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Onsite installation | Prerequisites

To begin with Multisite system configuration, make sure below steps are accomplished:

• System Builder jobfile prepared during offsite commissioning is stored on the cloud.

• All luminaires are installed, wired, and powered ON

• Sensors and user interfaces are installed and wired according to installation manuals

• Controllers are wired in the distribution board (Power & Dynet) and powered ON

• Basic checks are performed to ensure correct wiring to the controllers

• Customer IT network is successfully scanned using the Interact Connectivity Toolbox 

• PDDEG-S site gateway is ready to be connected to the cloud

• Philips Dynalite Enabler app is installed on the phone

• The work order is checked using the mobile app

• A Dynalite DTK-622USB PC Node is available (for Win11 recommended yellow version)

• The latest System Builder software is installed with an enabled Technician license

• The latest PDDEG-S firmware is downloaded from the Partner Portal (FLX Architecture)

Multisite
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Learning objectives | Onsite installation, commissioning and validation

At the end of this lesson, you should be able to:

• Describe the steps required for the on-site 
commissioning and validation process.

• Be familiarized with the tools needed for online 
commissioning.

Onsite activities 

Site Gateway

Commissioning

Site validation 

Project delivery

Multisite

Validate Metered Energy Feature

Modbus Meters settings  

Upgrade Dynalite Firmware

Validate Emergency light testing 
feature

Finalize Emergency light testing 
configurations

Optional features configuration

1. Chrome web browser

2. Philips Dynalite Enabler app

3. System Builder >4.43 with technician license

4. Prepared SB job file in the cloud

Prerequisites:



Site gateway
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Mute/Unmute – new feature since SB 4.43

1. Any time you remotely connect to a project, it will 

be automatically set as Dynet mute to avoid 

mistaken interactions that can affect the system.

During Dynet Mute:

o Devices can still be signed on, but not 

reset, rebooted, loaded, or saved from SB.

o Troubleshooting logs can be read from PDDEG-S 

after it's been signed-on.

o Other SB features that might send Dynet messages 

are disabled such as: Virtual Panel, Start Task, etc.

2. To allow SB standard functionalities, select Disable 

Dynet mute from the toolbar icon or the Tools menu.

Multisite
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Site gateway | Open Job file from the cloud

Login to the cloud

Connect the PC to the Internet and run System Builder

1. On the Tools menu, click Interact Accounts

2. Click Add and select Multisite Account

3. Select the Region and click OK

4. Select your account to login to. If required, fill in your password

5. Account has been linked with the Multisite cloud

Open job file from the cloud

6. On the File menu, click Open and select Open Job From Cloud

7. In the Work Order Selection menu, select the Region

8. Select the work order that belongs to the site, then click OK

Wait a moment until the file is successfully loaded

5
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Site gateway | Upgrade PDDEG-S

Localize and upgrade gateway

1. In the System view, select the PDDEG-S.

2. On the Tools menu, click Localize Devices by Sign-on.

3. Push the sign-on button on the gateway. In the Localize Device dialog box, click Localize.

4. Right-click the device and select Firmware Upgrade.

5. Select the new firmware file and click Start. Wait until the upgrade process is finished.
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Site gateway | PDDEG-S network configuration

Configure network settings 

1. In the System view, select the PDDEG-S

2. On the Ports tab, click Advanced to expand additional configuration options

3. Select one of the following:

         - Use static IP address to False, to obtain dynamic settings of the customer IT network

         - Use static IP address to True, to configure static IP and network settings manually.

           Always use static IP address configuring Metered Energy with PDEB/PDEG

4. With the Static IP set to True, manually set Gateway, Subnet mask, DNS server,                

and Alternative DNS server 

5. Right-click the device and select Save To Device. Select Resave all device data, click OK.

6. Right-click on the PDDEG-S and Send Device Reboot to apply new network configurations.

Save job file to the cloud

7.      Save modified job file to the Cloud. Make sure to use a proper Work Order

Wait until the file is successfully saved to the cloud. Observe progress in the Application logs
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Site gateway | Activate PDDEG-S 1/2

1. Run the Philips Dynalite Enabler app, select the Region 

and  relevant Work Order

2. Tap Start commissioning

3. Tap Establish connectivity

4. Select Use available internet connection while using customer IT 

outbound connection

5. Select Set up 4G connectivity device, while  using  4G modem 

delivered by Signify. Follow further on-screen instruction

6. Tap Done          

    

5
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Site gateway | Optional 4G modem configuration

About the Modem:

1. Out-of-the-box connectivity device.

2. Equipped with an internal soldered SIM which is ready for use.

3. Includes the following accessories: a 1.5m Yellow Ethernet 

cable, 2 cellular antennas to provide optimum signal 

strength and 1 DIN rail mounting bracket

4. It requires 24V DC, 1.5A Power Supply which needs to be 

ordered independently.

5. At the back of each modem there's a sticker with a unique bar 

code which will be required by the Philips Dynalite Enabler 

app.

Multisite
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Advices:

1. Ensure you install the modem in an area with enough network coverage.

2. After the external power source is switched on, wait 2 minutes for 

confirming the modem connects to the mobile network.

3. The Vodafone MachineLink 4G Lite router uses eight LEDs to display the 

current system and connection status.

Onsite commissioning

Site gateway | Optional 4G modem configuration

Multisite
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Task 7: Activate gateway 2/2 

Activate gateway:

1. Click on the PDDEG-S Gateway to assign it

2. Check on PDDEG-S if the bottom led flashes:

• If so, tap Yes

• If not, tap No and follow the steps in the app

3. Scan the QR-code on the PDDEG-S

4. After reading the message Gateway Connected, tap OK

5. Wait for the gateway to be assigned. It can take up to 30 minutes

Status of gateway assignment can be observed in the mobile app. Take a 

short break ☺

    

3

Multisite

3

1

2

4

5



Commissioning

Architecture FLX - Multisite



Signify Classified - Internal

Onsite commissioning

14

Commissioning | Assign box numbers

With PDDEG-S gateway successfully assigned to the cloud, further commissioning 

process is handled in the System Builder software.

Assign box numbers to devices in the job file

1. In the System Builder, open the job file from the cloud.                                           

Make sure to use a proper Work Order.

2. Connect PC to the DyNet network

3. In the System view, select either load controller, user Interface, integration device 

or sensor

4. On the Tools menu, click Localize Devices by Sign-on

5. Push the sign-on button on the device. In the Localize Device dialog box, click 

Localize. Use sign-on by torch, or dedicated IR remote controller for sensors that 

are difficult to reach.

6. After successful box number assignment re-save configuration to the device.

7. Repeat steps for all devices in the DyNet network. 

4
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Commissioning | Configure DALI

DALI individual addressing  (DDBC120-DALI, DDBC320-DALI)

If System Designer and graphical commissioning have been used during 

offsite preparation, Load and BLA settings will be applied automatically 

after localizing the luminaires. Check if this is the case, otherwise, 

once all DALI ballasts are enumerated for a selected controller:

1. On the Outputs tab (A), map the Physical Channels (B) to the 

correct Child areas (C) and Logical Channels (D)

2. In the column Base Link Area (E), map the number of 

the  Child area (C) with the Parent Area. Reflect Project 

Template and the IAR Cloud configuration

3. Calculate and fill in the Load (F) in Watts and select the Power 

Category (G) of the physical channel

4. Right-click the device and select Save To Device. Select Resave all 

device data and click OK

5. Repeat for other DALI individual addressing devices

Onsite commissioning
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Commissioning | Finalize configurations

Configure sensors

Most of the sensor configurations are finalized during the Offsite preparation, and have been described in the 

previous module:  System Builder | Additional configurations – Sensors 

Offsite configurations are already saved to the physical devices.

During Onsite installation:

• While using DALI sensors make sure to enumerate these devices and assign correct box numbers.

• While using Daylight harvesting feature make sure to calibrate all involved sensors.

• Validate if the sensors work as expected.

• Remember to always use Resend Inhibit Period for motion detection functionality.

Configure user interfaces

Most of the sensor configurations are finalized during the Offsite preparation, and have been described in the 

previous module:  System Builder | Additional configurations – User Interfaces

Offsite configurations are already saved to the physical devices.

• During Onsite installation please validate if the user interfaces work as expected

Multisite



Signify Classified - Internal

Onsite commissioning

17

Commissioning | Finalize configurations

Configure Dry contact interfaces

Dry Contact Interface configuration is usually finalized during the Offsite preparation, and have been 

described in the previous module:  System Builder | Additional configurations – Alarm integration

Offsite configurations are already saved to the physical devices.

• During Onsite installation please validate if the user dry contact integrations work as expected

Multisite
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Commissioning | Verification

Make sure that the Building view of the job file shows:

1. 100% Devices Saved

2. 100% Fixtures Assigned

Multisite
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Commissioning | Save SB job file to the cloud

Save final job file to the cloud

1. Make sure System Builder is connected to the Multisite account

2.     On the File menu, click Save As and select Save Job To Cloud

3.     In the Work Order Selection menu, select the Region: Europe

4.     Find and choose applicable work order, then click OK

Wait until the file is successfully saved to the cloud. Observe progress in the Application logs.

1

3

4
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With all DALI luminaires addressed during onsite visit:

1. Sign-on all DALI controllers to ensure all are reachable

2. Go to Emergency Testing tab

3. Click on Default Emergency Group

4. Configure Automatic Test Properties, disabling Functional 

and Duration tests

5. Click Save to Driver(s) button. Monitor in network log 

saving progress

Onsite commissioning 

Connected emergency lighting testing 
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Remote Emergency Light testing feature, requires DALI 

controllers that are upgraded to :

• minimum FW version 1.12 / 2.12 for DDBC320

• minimum FW version = 1.22 / 2.22 for DDBC120

SB minimum version – 4.44.9 

With all DALI luminaires addressed during onsite visit:

1. Go to Emergency Testing tab

2. Divide EM ballasts into existing Emergency Groups

3.     Click Manage Test Config

4.    Select Test Configuration and click Assign Emergency Group

5.    Link desired Emergency Group(s) with corresponding Test    

Configuration

6. Repeat for all Test Configurations 

7. Click “Save to Gateways” button

Onsite commissioning 

Connected emergency lighting testing 1
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Please note that prior to this step:

• For existing projects -> Re-deploy concept and schedule from the cloud

• For new projects -> make initial deployment from the mobile app first

Create Emergency Schedules

1. After deployment load from PDDEG-S and go to Schedules tab

2. Schedules deployed from the Cloud will be enabled and consist of “IAR_” 

prefix. Localize first grayed out  “IAR_Undefined schedule” and give it an 

appropriate name e.g. Functional or Duration Test for group X

3. Specify as an action Emergency Test Instance with desired Test   

configuration number

4. Ensure Emergency schedule is: Enabled, and flags Unused and Suspendable 

are not selected

5. Specify EM schedule occurrence based on input received from customer.

6. Repeat EM schedule creation process for each Test Configuration and test 

type

7. Save changes to PDDEG-S and save job file to the Cloud.

Connected emergency lighting testing 
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Validation in System Builder

1. Go to Schedules tab on PDDEG-S.

2. Ensure all EM schedules are properly configured

• Check defined actions

• Validate execution time and schedule occurrence

3.  Localize Schedule for Functional test and click on it.

4.  Click Run to manually execute functional test

5 . Observe in network log files:

• If Functional test has been properly started for desired 

emergency groups

• Result of functional test is successful for all luminaires.

Connected emergency lighting testing 

4
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Validation in the Cloud 

1. Check in Assets Tab and on the Emergency lighting tests 

tile, if result of the performed test is reflected there.

2. In Site list view select the site and go to Emergency Tests 

tab . Observe if Emergency test results are populated.

Connected emergency lighting testing 

1

2
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While using Modbus RS485 architecture :

o Update PDDEG-S firmware version to 1.23 or higher.

o Upgrade PDEG/PDEB firmware version to 3.58 or higher.

o Upgrade DDNG485v3 firmware version to the latest version.

Modbus Meter settings:

o Configure Meter Address and Baud Rate (supported Baud Rates are : 9600, 19200, 38400).

o Configure other Data Format parameters as follow: Half-duplex, Data bits 8, Parity None, Stop bits 1.

o Ensure IP Address on the Modbus Meter equals IP address configured on the Meter in System Builder.

o Ensure Port specified on the Modbus Meter equals port configured on the Meter in System Builder.

o Verify general electrical configurations and if applicable configure Current Transformers ratio.

Onsite commissioning

29

Multisite metered energy | Additional configurations

Multisite
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Multisite metered energy | Onsite validation

1. In the System view, click on the Modbus Meter.

2. Go to Modbus Configuration Editor tab.

3. Right click on the Active Energy register and select Request 

Register Value.

4. Confirm that Register Value is being populated. Verify 

against expected consumption.

5. Observe SB network logs and confirm that Binary Metric 

Data is being generated every 15 minutes.

Note: Approximately after 1 hour the Metered Energy data will 

start to be presented in the Customer`s dashboard.
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Site validation | Mobile app

Validate Areas, Child Areas and Logical Channels

1. In the app, tap Validate site installation

2. Tap the name of a Parent Area

3. Tap the name of  a Child Area

4. Tap the name of a Logical Channel

5. Tap the buttons and check visually if the lights respond accordingly. 

Correct if necessary.

6. When the lights respond as expected, tap Yes, confirm

Repeat for all existing Parent Areas, Child Areas and Logical Channel

Make sure Site, Areas, Child Areas and Logical Channels are validated → 
 

Multisite
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Site validation | Mobile app

Deploy and validate concepts and schedules

Please make sure, that the default concept and schedule

are prepared in the cloud during Offsite preparation

1. In the Tasks page, tap Deploy concept and schedule

2. Tap Yes, confirm, to deploy default concept and schedule

3. Tap Validate concept and schedules

4. Tap the name of a Parent area

5. Tap the buttons and check visually, if the lights respond accordingly. 

Correct if necessary.

6. When the lights respond as expected, tap Yes, confirm

Repeat for all other Parent areas. Make sure to validate all Areas → 

Multisite
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Site acceptance test 

For a complete revision, use the Site acceptance 
test document located in the Partner Portal 
under:

Technical documentation>Architecture FLX - 
Multisite

Use this Excel to check in Multisite 
System Manager if the commissioning 
has been fully done. System Builder 
checks are also included in this 
document to ensure there won't be any 
issues due to wrong or missing 
configuration.

Multisite

https://partner-portal.cfapps.eu10.hana.ondemand.com/internal/index.html
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Project delivery | Mobile app

On the successful  Site validation, all the Tasks are completed and marked as 

Resolve work order

1. Tap Resolve work order

2. Tap Yes, confirm to resolve the work order

3. Work order changes the state to Resolved

Congratulations !!! 

Site is ready to use ! 

Multisite
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Project delivery | Customer handover

With the Multisite System fully commissioned , Site-Engineer delivers the project  to the Market 

organization.

It is up to the Market to plan the final handshake with the Customer, either on-site or remotely.

For the successful handover:

1. Make sure a user account is created for the customer (OTRS ticket)

2. User has an appropriate role assigned of the Format or the Facility Manager (OTRS ticket)

3. Print out the latest User Guide document.                                                                                                                 

This document can be found on the Signify Partner Portal or directly in the cloud Dashboard

4. Based on the User Guide train the Customer on how to use our system.

Engage with the Customer using a monthly generated report. 

Use this opportunity to discuss further projects and gain feedback on our system.

3
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C4CS / BSR

C4CS ticket: BSR (Business support request) 

Multisite

Business support request ticket

To request System Expert support always create BSR ticket in the C4CS system

Follow specific to your organization Business Support Request ticket (BSR)

• CSAT - follow standard BSR ticket creation process:

• S&S - follow “one stop” approach: 

• CSI – use the webform on the new Partner Portal

While creating BSR ticket (applicable for CSAT and S&S) remember to:

• Accurately phrase your question, attach all related files, describe project, 

configuration, software firmware versions.

• Specify a proper system architecture : FLX

• Address ticket to System Experts team (not to the specific person)

 

Instruction for CSAT

Instruction for CSAT

http://www.c4cs.signify.com 
http://www.c4cs.signify.com 

Instruction for SS
Instruction for S&S 

https://www.mylighting.signify.com/index.html
https://eu.degreed.com/learning/search?term=Training%20C4CS
https://share.lighting.com/teams/LearningSignifycontentshare/Shared%20Documents/Forms/AllItems.aspx?id=%2Fteams%2FLearningSignifycontentshare%2FShared%20Documents%2FGeneral%2FLGS%2FInstruction%20for%20Customer%20Satisfaction%20to%20create%20BSR%20in%20C4Cs%2020230414%2Epdf&viewid=8284e2e8%2Dc35c%2D4573%2Db699%2D0a3465cca244&parent=%2Fteams%2FLearningSignifycontentshare%2FShared%20Documents%2FGeneral%2FLGS
http://www.c4cs.signify.com/
http://www.c4cs.signify.com/
https://eu.degreed.com/learning/search?term=Training%20C4CS
https://share.lighting.com/teams/LearningSignifycontentshare/Shared%20Documents/Forms/AllItems.aspx?id=%2Fteams%2FLearningSignifycontentshare%2FShared%20Documents%2FGeneral%2FLGS%2FInstruction%20for%20S%26S%20Market%20teams%20to%20create%20BSR%20in%20C4Cs%2020230414%2Epdf&viewid=8284e2e8%2Dc35c%2D4573%2Db699%2D0a3465cca244&parent=%2Fteams%2FLearningSignifycontentshare%2FShared%20Documents%2FGeneral%2FLGS
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Lesson review | Onsite installation, commissioning and validation

In this lesson, you:

• Explored the four steps to be taken in the on-site commissioning and validation process
• Site gateway configuration: saving and upgrading the bridge through System Builder, 

and establish connectivity through the Philips Dynalite Enabler app.
• Commissioning: resaving the final System Builder project to the cloud after localizing 

and saving all devices on the network, including the individual DALI physical channels 
when needed.

• Optional configuration for Connected Emergency light testing and  Energy Metering
• Site validation: divided into validation and deployment of both schedule and concept.
• Hand over to the end user: which requires to resolve the work order.

• Got familiarized with the tools required for onsite commissioning.

Multisite
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